
Chapter 1

Introducing NVivo

This is a book for three kinds of learners:

• Those who prefer to learn by doing;
• Those who want to learn new tools for data management and analysis

on a need-to-know basis;
• Explorers, who just want to play around and see what this software

might do for them.

Through the course of undertaking a qualitative analysis project using this
book, you will find out how to use one particular software program, NVivo.1 On
the way, you will find references, explanations and advice to help you understand
what you are doing and why. And as you learn to ‘drive’ the software, you will
also move along the road to completion of your project – a triple benefit! 

In this chapter:

• Discover how use of software can support you in doing qualitative
research;

• Read the story of how NVivo came to exist, and its intellectual history;
• Consider issues and objections people have raised about use of software

for qualitative research;
• Get a sense of how NVivo will help you work with your data; and
• View an outline to guide your journey through the software and this book.

QUALITATIVE RESEARCH PURPOSES AND NVIVO

Researchers engage in projects involving interpretation of unstructured or semi-
structured data for a variety of reasons. These might include exploration,
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description, comparison, pattern analysis, theory testing, theory building, or
evaluation.

Methodologists routinely urge researchers to assess the fit between purpose
and method (Maxwell, 2005; Richards & Morse, 2007), with the choice to use
a qualitative approach being determined by the research question and purpose,
rather than by prior preference of the researcher. Qualitative methods will be
chosen in situations where a detailed understanding of a process or experience is
wanted, where more information is needed to determine the exact nature of the
issue being investigated, or where the only information available is in non-
numeric (e.g., text or visual) form. Such investigations typically necessitate gath-
ering intensive and/or extensive information from a purposively derived sample,
and they involve interpretation of unstructured or semi-structured data. 

How NVivo supports qualitative analysis

QSR International, the developers of NVivo, promise only to provide you with a
set of tools that will assist you in undertaking an analysis of qualitative data. NVivo
has been developed by researchers, with extensive researcher feedback, and is
designed to support researchers in the varied ways they work with data. The use of
a computer is not intended to supplant time-honoured ways of learning from data,
but to increase the effectiveness and efficiency of such learning. The computer’s
capacity for recording, sorting, matching and linking can be harnessed by the
researcher to assist in answering their research questions from the data, without
losing access to the source data or contexts from which the data have come.

The average user of a software program typically accesses only a small pro-
portion of its capabilities; this is no doubt true for users of NVivo also. Those
using NVivo for a small descriptive project, for example, can work without hav-
ing to learn complex procedures, while those undertaking complex analytical
tasks can find the additional tools they need.

There are five principal ways in which NVivo supports analysis of qualitative
data. Using software will assist you to:

• Manage data – to organize and keep track of the many messy records
that go into making a qualitative project. These might include not just
raw data files from interviews, questionnaires, focus groups or field
observations, but also published research, other documentary sources,
rough notes and ideas jotted into memos, information about data
sources, and conceptual maps of what is going on in the data.

• Manage ideas – to organize and provide rapid access to conceptual and
theoretical knowledge that has been generated in the course of the study,
as well as the data which supports it, while at the same time retaining
ready access to the context from which those data have come.

• Query data – to ask simple or complex questions of the data, and
have the program retrieve from its database all information relevant to
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determining an answer to those questions. Results of queries are saved
to allow further interrogation, and so querying or searching becomes
part of an ongoing enquiry process.

• Graphically model – to show cases, ideas or concepts being built from
the data, and the relationships between them, and to present those ideas
and conclusions in visual displays using models and matrices.

• Report from the data – using contents of the qualitative database,
including information about and in the original data sources, the ideas
and knowledge developed from them, and the process by which these
outcomes were reached.

There is a widely held perception that use of a computer helps to ensure rigour
in the analysis process. Insofar as computer software will find and include in a
query procedure, for example, every recorded use of a term or every coded
instance of a concept, it ensures a more complete set of data for interpretation
than might occur when working manually. There are procedures that can be
used, too, to check for completeness, and use of a computer makes it possible to
test for negative cases (where concepts are not related). Perhaps using a computer
simply ensures that the user is working more methodically, more thoroughly,
more attentively. In these senses, then, it can be claimed that the use of a com-
puter for qualitative analysis can contribute to a more rigorous analysis. Even so,
human factors are very much involved, and computer software cannot make-
good work that is sloppy, nor compensate for limited interpretive capacity. As
much as ‘a poor workman cannot blame his tools’, good tools cannot make up
for poor workmanship.

Perhaps surprisingly, the tools described in this book are ‘method free’ insofar
as the software does not prescribe a method, but rather it supports a wide range
of methodological approaches. Different tools will be selected or emphasized and
used in alternative ways for a variety of methodological purposes. 

We reiterate that no single software package can be made to 
qualitative data analysis in and of itself. The appropriate use of soft-
ware depends on appreciation of the kind of data being analyzed
and of the analytic purchase the researcher wants to obtain on those
data (Coffey and Atkinson, 1996: 166).

There are, nevertheless, some common principles regarding most effective use
for many of the tools, regardless of methodological choices. For example, the
labels used for coding categories will vary depending on the project and the meth-
ods chosen, but the principles employed in structuring those categories in a hier-
archical coding system are common to virtually all methods where coding takes
place. These common principles allow me to describe in general how you might
use the various tools. It is then your task to decide how you might apply them to
your project. Pointers to particular strategies which might suit particular method-
ological approaches are provided throughout this book, however.
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If you are coming to NVivo without first meeting methodology or methods,
then you are strongly advised to read first some general or discipline-based intro-
ductory texts. Then use the recommended reading lists in those, references in this
book, or Google ‘qualitative research’ to further explore the methodological
choices available to you.

THE NUD*IST-NVIVO STORY2

NUD*IST 1 was born in 1981 after Tom Richards set out, in 1979, to master pro-
gramming in order to assist his sociologist wife, Lyn Richards, in managing the
data files from a large neighbourhood research project. At the time, Tom was an
academic, teaching logic at La Trobe University in Melbourne and just moving
into computer science, while Lyn was a family sociologist, also teaching at La
Trobe University. Lyn provides a rather delightful description of the problems she
was experiencing with paper coding techniques, specifically when multiple
copies of a segment of text had to be made and sorted into piles: a task that “was
boring, time consuming, and not very rigorous, since dogs and babies were likely
to mix with the precious paper segments” (L. Richards, 2005, p. 89). The particu-
lar experience of her two-year-old son crawling through the piles of data on the
lounge room floor and eating a never-to-be-retrieved quote sparked the conver-
sations which led to development of the program of which she referred to herself
as ‘mother’, while noting (in conformation to contemporary mores) that it had a
legitimate ‘father’.

The software was designed with a dual database, most obviously evidenced in
the first graphical interface versions. These showed two main windows on the
screen: one was a window into a document system, which held all the ‘raw’
research data, and the other was a window into a coding system, which held the
researcher’s evolving knowledge about the data. Ideas and concepts drawn from
the data were stored in ‘nodes’ which held references to the source text. This sys-
tem of text referencing allowed the retrieval, from the documents, of all the text
passages currently coded at the node (meeting a need to code-and-retrieve), but
it did more. The separation of node from document was both innovative and
pivotal; it is what has made possible manipulation and revision of categories
while retaining links to the evidentiary texts (T. Richards, 2002). In doing so, it
allowed for the emergent nature of knowledge gained through interpretive analy-
sis. Additionally, and uniquely, nodes were organized in a hierarchical tree struc-
ture, a cataloguing system which enabled sorting (and thus classification) of the
categories being derived from the data.

The needs of qualitative researchers to pursue leads in their data required, how-
ever, that a computer program be able not only to retrieve all the text on a par-
ticular topic, but also to find text related to a combination of topics through
interrogative searches. Then, perhaps, that found text might also become data into
a further enquiry relating it to something else – a revolving results-data-results
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process referred to as ‘system closure’ (T. Richards, 2002). Tom recognized, also,
the value of being able to obtain the results of multiple comparisons in one query
procedure – the ability to examine, for example, gender differences (male,
female) across a range of attitudes (or experiences, or issues, or …), or to identify
which solutions were used in relations to which problems – hence the idea of
matrix searches where the patterning of relationships between concepts repre-
sented by sets of nodes could be viewed in a ‘qualitative cross-tabulation’.
NUD*IST 1 (and later versions) supported 17 ways of interrogating coded data,
allowing both logic based (Boolean) and fuzzy (proximity) queries, almost none
of which had been possible using manual methods of coding and analysis. 

Experience with issues raised by NUD*IST 1 led to the development in 1987
of NUD*IST 2, still on mainframe. Version 2.3, in 1990, took the software onto
Macintosh, but the program still had a mainframe-style, scroll-mode interface,
requiring for example that coding be done on paper and then transferred into the
computer using typed instructions (in document ‘X’, code text units 20–23 at
node (3 4)). Version 2 was the first made available to the public for purchase.
(I bought version 2.3 early in 1991, with licence number 38!)

Development of a windowing interface resulted in NUD*IST 3, released on
Macintosh in 1993 (with no mainframe version), and on PCs using Windows 3.1
soon after, in 1994. NUD*IST 3 allowed for on-screen selection and coding of
document text, and was particularly characterized by the display of nodes as a
visual tree. It also saw the addition of a series of processing refinements which
allowed for editing of text units, the placing of restrictions on the scope of
searches (which effectively reduced a step in repeated searching), and, some time
later, the innovative ability to merge two projects into one. A command file sys-
tem for automated processing of routine coding and searching tasks, was avail-
able in earlier versions. 

With the growing world-wide adoption of NUD*IST 3 it became necessary to
move out from the corner of Tom’s laboratory in the computer sciences building,
and to establish a company – Qualitative Solutions and Research Pty Ltd – to
handle program development and marketing. Qualitative Solutions and Research
became independent of La Trobe University in 1995, and was later renamed QSR
International.

The release of NUD*IST 4, in April 1997, provided much greater flexibility in
working with data stored at nodes. The concept of the ‘free node’ was born, a
node placed outside the tree structure until (and if) an appropriate place in the
hierarchy could be determined. More significantly, ‘live’ access to coded data, via
the node, allowed for recoding of already coded material, without having to
return to the original documents. Data, now recontextualized at nodes, could be
further coded while viewing the node, and that coding would ‘stick’ to the text,
regardless of from where it was viewed. This was a major advance in qualitative
computing. 

Also in N4, the ability to import demographic and other quantitative data
directly from table-based software made for greatly improved efficiency in

I N T R O D U C I N G  N V I V O 55

Bazeley-3503-Ch-01.qxd  12/15/2006  7:06 PM  Page 5



entering and using such data. Additionally, counts of documents coded at a series
of nodes or in cells of a matrix, or of volume of text as represented by text units,
could be exported from the program, facilitating its use for mixed methods
research. Further refinements in versions 5 (N5-2000) and 6 (N6-2002) automated
the formatting of text units, gave more flexibility in the handling and editing of
text units, and made it easier to access and report on matrix results. N5 and N6
were actually released after NVivo as the programs of choice for large, repetitive,
or highly structured projects (facilitated by command files).

The parallel release of NVivo 1 in 1999 met three specific needs of qualitative
researchers (T. Richards, 2002): to apply character-based coding, to have the facil-
ity of rich (formatted) text available, and to be able to freely write or edit text,
without invalidating earlier coding. Provision was made for linking to other media
(of any sort), and to split the tasks being carried by nodes. A case nodes area was
added alongside free and tree nodes; attributes with values replaced nodes for
holding demographic and other quantified data; flexible sets of documents or of
nodes replaced the use of coding to allow restrictions in (scoping of) searches. A
visual modeller that allowed nodes (and other data items) to be viewed in any
kind of relationship was added, to allow for concept mapping. Processes of cod-
ing and working with data became more visual and more flexible in NVivo, mak-
ing it a program of choice for working in a fine grained way with data.

With NVivo 7, the two lines of software development were brought together in
an entirely new database, to cater for a researcher needs to undertake projects
ranging from fine, deeply reflective analysis to analytic processing of larger vol-
umes of text sources. In learning to use NVivo 7 and later versions, researchers
still draw on the rich heritage of foundations laid in NUD*IST 1.

ISSUES RAISED BY USING SOFTWARE FOR
QUALITATIVE DATA ANALYSIS

“Tools extend and qualitatively change human capabilities” (Gilbert, 2002:
p. 222). Users of tools provided by NVivo may face opposition from those who
express doubts about using software for analysis of qualitative data, or who
simply have an aversion to technological solutions. Concern about how using a
software program impacts on method is not limited to aging professors, and has
attracted some debate at conferences and in the literature. If this is not an issue
for you, feel free to move on to the next section of this chapter.

The development of software tools and advances in technology in general have
had significant impacts on how research is done. These impacts are not limited
to qualitative data analysis. The constantly expanding use of the web to provide
access to data is now extending and changing the process of qualitative inter-
viewing as well as the structure of surveys and survey samples. The widespread
use of tape recorders in interpretive research has changed both level and kind of
detail available in raw material for analysis, and as video recording becomes
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more common, data and method will change again. Tools range in purposes,
power, breadth of functions, and the skill demanded of the user. The effective-
ness with which you can use tools is partly a software design issue – software can
influence your effectiveness by the number or complexity of steps required to
complete a task, or by how information is presented to the user. It is also a user
issue – the reliability, or trustworthiness, of results obtained depends on the skill
of the user in both executing method and using software. The danger for novices
using a sophisticated tool is that they can ‘mess up’ without realizing they have
done so (Gilbert, 2002).

Historically, the use of qualitative data analysis software has facilitated some
activities, such as coding, and limited others, such as seeing a document as a
whole or scribbling memos alongside text. In so doing, early computer programs
somewhat biased the way qualitative data analysis was done. Historically, also,
qualitative researchers were inclined to brand all qualitative data analysis soft-
ware with a capacity for supporting code-and-retrieve activity as being designed
to support grounded theory methodology3 – a methodology which has become
rather ubiquitously (and inaccurately) associated with any data-up approach –
with the implication that if you wanted to take any other kind of qualitative
approach, software would not help.

Lyn Richards (2002) argues that the most radical methodological changes
which came about with qualitative computing were not in what the computer
could do, so much as the uses to which it could be put in furthering analysis. That
coding could be done using a computer was not in itself a methodological
advance, but the complexity and detail with which coding was made possible by
computers, and the benefit of that in driving a complex and iterative data inter-
rogation process, provided the basis for a radical shift in researchers’ approaches
to both coding and analysis.

Concerns about the impact of computerization on qualitative analysis have
most commonly focused around four issues4 which are discussed below:

• The concern that computers can distance researchers from their data; 
• The dominance of code and retrieve methods to the exclusion of other

analytic activities; 
• The fear that use of a computer will mechanize analysis, making it more

akin to quantitative or ‘positivist’ approaches; and
• The misperception that computers support only grounded theory

methodology, or worse, create their own approach to analysis.

Closeness and distance

Early critiques of qualitative data analysis software suggested that users of software
lost closeness to data through poor screen display, segmentation of text and loss of
context, and thereby risked alienation from their data. The alternative argument is
that the combination of tape recorders and software can give too much closeness,
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and so users become caught in ‘the coding trap’, bogged down in their data, and
unable to see the larger picture (Gilbert, 2002; L. Richards, 1998). 

Recent software has been designed on the assumption that researchers need
both closeness and distance (L. Richards, 1998): closeness for familiarity and
appreciation of subtle differences, but distance for abstraction and synthesis –
and the ability to switch between the two. Closeness to data – at least as much
as can be had using manual methods – is assisted by improved screen display,
rapid access to data through documents or retrieval of coded text, identification
of data in relation to source characteristics, and easy ability to view retrieved seg-
ments of text in their original context. Other tools are designed to provide dis-
tance, for example, tools for modelling ideas, for interrogating the database to
generate and test theory, for summarizing results. These take the researcher
beyond description to more broadly applicable understanding. Moving between
these tools, from the general to the specific, and from the specific to the general,
back and forth, exploiting both insider and outsider perspectives, is characteris-
tic of qualitative methods and contributes to a sophisticated analysis.

Domination of code and retrieve as a method

The development of software for textual data management began when qualita-
tive researchers discovered the potential for text storage and retrieval offered by
computer technology. Hence, early programs became tools for data storage and
retrieval rather than tools for data analysis, simply because that was what they
were best able to do. The few programs that went beyond retrieval to facilitate
asking questions about the association of categories in the data, particularly non-
Boolean associations such as whether two concepts occurred within a specified
level of proximity to each other (e.g. NUD*IST, Atlas-ti), were less rather than
more common, and in these early stages were given special status as second-
generation ‘theory-building’ programs (Tesch, 1990).

Computers removed much of the drudgery from coding (cutting, labelling and
filing); they also removed the boundaries which limited paper-based marking and
sorting of text. 

When recoding data involves laborious collation of cut-up slips and
creation of new hanging folders, there is little temptation to play
with ideas, and much inducement to organise a tight set of codes
into which data are shoved without regard to nuance. When an obe-
diently stupid machine cuts and pastes, it is easier to approach data
with curiosity – asking “what if I cut it this way?”, knowing that
changes can be made quickly (Marshall, 2002: 67).

Simply making coding more efficient was not, in itself, a conceptual advance
from manual methods of data sorting (Coffey & Atkinson, 1996). Criticism that
segments of text were removed from the whole, creating a loss of perspective, was
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frequently levelled at computer software (apparently without recognition that
cutting up paper did the same thing, but with even greater risk of not having
identified the source of the segment). Fears were expressed that computers would
stifle creativity and reduce variety as code and retrieve became the dominant
approach to working with data, to the neglect of extensive memoing, linking of
ideas, holistic viewing of the text, and visualizing techniques. 

Most problematically, the facility for coding has led to a kind of ‘coding
fetishism’ – a tendency to code to the exclusion of other analytic and interpretive
activities, which biases the way in which qualitative research is done
(L. Richards, 2002). Historically, prior to the development of computer software
for coding, much more emphasis was placed on reading and re-reading the text
as a whole, on noting ideas that were generated as one was reading, on making
links between passages of text, on reflecting on the text and recording those
reflections in journals and memos, and on drawing connections seen in the data
in ‘doodles’ and maps. Chapters 4 and 5 in this book provide suggestions for how
to strike a balance when working with data using a computer, to combine cod-
ing with reading, reflecting, linking, noting, and doodling.

Viewed positively, ready retrieval of coded text allows the user to ‘recontextu-
alize’ the data, to see it anew through the category rather than through the case
or the document (L. Richards, 2002), and rapid access to original context of the
segment has overcome the problem of disconnection. Furthermore, capacity to
restructure a coding system facilitates the ‘playing with ideas’ referred to by
Helen Marshall as an essential part of creative analysis, as does live access to the
coded data so that, if desired, it can be reworked through further coding from the
node.

Computers and mechanization

Fears that the computer, like Frankenstein’s monster, might take over the analy-
sis process and alienate researchers from their data stem in part from the histor-
ical association of computers with numeric processing of data, and in part from
the computer’s capacity to automate repetitive processes or to produce output
without making obvious all the steps in the process. In addition, the association
of computers with statistics, systematic processing, rigour and objectivity have all
contributed to the (mis)perception of an association of computerization with pos-
itivism, whereas the majority of qualitative researchers are working within more
interpretive paradigms. 

The tendency of some authors to equate computer-based coding with mecha-
nized coding procedures based on the search for keywords within the text adds
to their and others’ concerns about the computer alienating the researcher from
the analysis process (cf. FQS, 2002). There are software programs designed to
automate the coding process entirely, necessitating the development of complex
dictionaries and semantic rule books to guide that process, but these are
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specifically designed for quantitative purposes, and the results of their coding are
interpreted through the use of statistics without recourse to the original text
(Bazeley, 2003). Keyword searches within qualitative analysis will almost always
be secondary to interactive coding of the data, if they are used at all.

Automated coding processes have a place in handling routine tasks (such as
identifying the speakers in a focus group), or perhaps in facilitating initial explo-
ration of the data or for checking thoroughness of coding. These remove
drudgery without in any way hindering the creativity or interpretive capacity of
the researcher. automated coding or keyword searches cannot substitute for
interpretive coding, however; meaningful coding still needs to be done interac-
tively (live on screen).

One of the goals of this book is to ensure that researchers using NVivo under-
stand what the software is ‘doing’ as they manipulate their data, and the logic on
which its functions are based – just as artisans need to understand their tools.
Such metacognitive awareness ensures researchers remain in control of the
processes they are engaging in and are getting the results they think they asked
for (Gilbert, 2002), while the more aware and adventurous users can experiment
with new ways of using NVivo’s tools to work with their data – as the good arti-
san knows how to make his tools ‘sing’ to produce a creative piece of work.

Homogenization of qualitative approaches
to analysis

You may hear researchers talk about ‘doing qualitative’ as if to imply there is just
one general approach to the analysis of qualitative data, but ‘qualitative’ is not a
method, and each attempt to define the characteristics of that general approach
results in a different set of criteria. While there are some generally accepted
emphases, there are also marked differences in qualitative approaches which stem
from differences in foundational philosophies and understandings of the nature
of social reality. The researcher must integrate their chosen perspective and con-
ceptual framework into their choices regarding what and how to code, and what
questions to ask of the data; software cannot do that.

Similarly, qualitative data analysis software has been talked about as if it sup-
ported just one qualitative methodology, or worse, that it created a new method.
The range of disciplines and perspectives of people who will use this book will
tell another story. In my own experience, I have taught NVivo to people in dis-
ciplines ranging from natural sciences through social sciences, business and the
professions to creative arts. Each has been able to find tools in NVivo to support
their work. 

As you work through this book, you will find descriptions and examples illus-
trating how adoption of different methods and methodological approaches can
influence your choices in using NVivo’s tools. But for now, it’s time to take a
look at NVivo, to get a sense of how it might be useful for your research.
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WHAT DOES AN NVIVO PROJECT LOOK LIKE?

Throughout this book I will be illustrating the principles and activities being dis-
cussed with examples from a number of my own projects, as well as some that
have been undertaken by colleagues or students, and others from the literature.
To give you an overview of the tools available for working in an NVivo project
and of what you might be working toward, we’ll stop to take a look at a
project which is at quite an advanced stage. Because it is a moderately mature
project, these instructions are not designed to show you how to make a start on
working in your NVivo project, but rather, of what will become possible as you
progress through your project.

As you read these instructions, and others in later chapters, you will encounter
a number of special icons: 

NV7

is the indicator that you are about to be provided with specific instructions for
working in the software. This needs an icon that is version free!

� indicates these are steps (Actions) for you to follow

� indicates a Tip or series of tips – handy hints to help you
through.

! indicates a Warning – ignore at your peril! 

The Researchers project

The Researchers project (based on real data and a serious research question)
comprises interviews, focus groups and written texts from researchers at differ-
ent stages of career development who have told of their developing involvement
in research or their experience of being a researcher. The study explores what
brings people into research, and what holds them there as committed, productive
researchers. Originally developed and partially completed using NVivo 1 as a
sample project for The NVivo Qualitative Project Book (Bazeley & Richards,
2000), it has now been reworked, added to, and set up as a progressively devel-
oped demonstration project for this book, using NVivo 7. You will find illustra-
tive examples drawn from the Researchers project throughout the book, marked
by    . When you meet them, you might use those examples to check how the soft-
ware works. For those who do not yet have their own data, the project provides
data on which a technique can be practiced. The Researchers project is available
for download from my web site (www resear chsupport. com.au) in several stages
of analytic development.
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For now, so we can view a project which is well underway, download the
Researchers tutorial project file and save it in the My Documents area of your
computer. If you are not able to access the Researchers project, then you might
follow the same instructions using the Volunteering tutorial project that comes
with the software.5

Setting up

If you don’t already have the software on your computer, then your first step to
using NVivo will be to install it either as a fully licensed or trial version on your
computer.6 Then you will be able to open the Researchers tutorial.

Use the Getting Started guide to find minimum computer requirements and
detailed instructions for installing the software. These simply require that you
insert the disk (or double click the downloaded software), have the license num-
ber that came with it ready to type into the appropriate part of the installation
wizard, and follow the steps as they appear on screen. It is likely that you will be
required, as part of this process, to install several supporting programs prior to
installing NVivo itself: the installation wizard will guide you through the neces-
sary steps. If you have a full license, you will then need to activate your license
via the internet or by contacting QSR, in order to keep using NVivo beyond the
30 day trial period (check Help > NVivo Help > Activating NVivo, or see the
Getting Started guide, if you’re not sure what this means).

When you first open the software, you might find it useful to view the
Introducing NVivo tutorial, accessed via the Help menu (NVivo tutorials). This
provides a brief overview of the various elements in an NVivo project, using data
from the tutorial provided with the software. Alternatively (or as well), the
instructions below will introduce you to NVivo using the Researchers tutorial (or
you could look at similar items in the Volunteering tutorial).

� If you have an earlier version (e.g., N6 or NVivo 2) on your computer, you
do not need to remove that before installing NVivo 7 or later. 

Introducing the NVivo workspace

Opening a project takes you into the project workspace from which you can
access all the software’s tools. Figure 1.1 illustrates the workspace and its com-
ponents for the Researchers project. Apart from a menu bar and several toolbars,
there are three areas, or views, for working in.

• From the Navigation View you can choose which component of the pro-
ject you wish to work on. Here, you can organize items in your project
into folders and sub-folders.
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• The List View lists the contents of a selected folder. Most importantly,
these can be opened from this view, and new contents can be added in
this view. The contents of a folder can be sorted, and the properties
(name and description) of items in the folder can be changed.

• The Detail View shows the actual content of an opened item, so that you
can work with it. 
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The contents of menus, toolbars and views can change depending on which
part of a project is active. In each view, context-sensitive menu items can be
accessed from the right mouse button (RMB).

� Whenever you’re not sure what to do or where to look for an action
when you are working in NVivo, ensure your cursor or mouse pointer is
pointing directly to the relevant item on your screen, and try the RMB as
a first option for finding what you want.

Figure 1.1 NVivo workspace showing menus, (adjusted) toolbars, and
Navigation, List and Detail Views
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As you explore the NVivo workspace using the Researchers project, you will
gain some appreciation of how NVivo can assist with organizing and analyzing
your data. Sources can be neatly filed; cases are identified with demographic and
other details; ideas are recorded and appropriately linked to their sources;
descriptive material and evidence for emerging understanding and ideas are cap-
tured in nodes; nodes are organized to facilitate querying the data so that
research questions might be clarified, developed and answered; and for those
who like to work visually, hunches, case analyses and emerging insights can all
be explored in models. 

NV7 A BRIEF EXCURSION THROUGH THE NVIVO WORKSPACE

NVivo opens to provide you with an option to create a new project or to open a
project. The first time you open any project in NVivo, other than those created
within it on your current computer, you will need to click on Open Project and
then navigate to locate the project. Thereafter, the project you have opened will
be listed as a Recently Used Project on the opening screen, and it will open when
you click its title. 

� Open the Researchers tutorial.

The workspace will first open to show Sources available through the Documents
folder. There are several types of documents stored in the Researchers project: these
have been organized into sub-folders designed to assist with data management. 

� Expand the Documents folder (click on the +) to see further folders for
various document sources (e.g., Interviews, Focus Groups). Click on one
of these folders to see its contents in List View.

� In List View, double-click a document to open it in Detail View. 

� Note the use of heading styles (the level of heading is identified in the
formatting toolbar when you click in the text) and other markers in the
text. Headings break the text into parts.

� If the text has blue highlighting, ask to View > Annotations (from the top
menus) or click on the view annotations button in the View toolbar.
Annotations are comments, reminders, or reflections on the text. Click
on a blue highlight and the associated comment will be highlighted.
Click on an annotation, and you will be shown the linked text.

� If words in the text have a red wavy line under them, it’s not a spelling
error, but an indicator for a see also link. See also links take to you other
documents, files or passages which relate to the marked text. Choose
RMB (right mouse button) > Open To Item to see the associated item.

� If the document has a linked memo (indicated by an icon next to the doc-
ument in List View), open that by hovering (holding the mouse pointer) over
the document name (or its text) and selecting RMB > Links > Memo Link >
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Open Linked Memo, OR, use Ctrl+Shift+M on your keyboard. Ideas and
thoughts stimulated by the document are recorded in its linked memo. 

� Note that you can have more than one document open at the same time:
use the tabs at the top of the Detail View to change which document you
are viewing. Close the document when you are finished with it (having
too many things open at once impacts on available memory).

� Do not close a whole series of windows in rapid succession! (Take a
breath between each one.)

Nodes provide the storage areas in NVivo for references to coded text. Each free
or tree node serves as a container for what is known about, or evidence for, one
particular concept or category.

� Click on the Nodes tab in the Navigation View to change the display from
sources to nodes, and then on Tree Nodes to see the list of nodes used
for coding in the later stages of this project. (Free nodes, which are not
structured in any way, were used earlier, but these have since been
moved into the more organized trees.) 

� Expand one of the trees in List View by clicking on the + next to it, then
select a node from within the tree by double-clicking. The text coded at
that node will be displayed in the Detail View below (Figure 1.2). The
source of each passage is identified, and the context from which a
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Figure 1.2 Tree Nodes with referenced text and context menu
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selected passage came can be accessed via the RMB (e.g., Coding
Context > Paragraph; or Open Referenced Source).

� Select Relationships in the Nodes area of the Navigation View. You will
then see in the List View, for example, that Elizabeth was encouraged by
a number of different people in her journey to becoming a researcher.
Additionally, a specific positive experience of encouragement can
prompt interest in and perhaps a career in research. Not all relationship
nodes have associated coding, but you can check the evidence gathered
for those that do (indicated in the References column) by double-click-
ing on the relationship node.

� Select Cases to see the list of participants and all the data held for each
in this project. Select a group participant, Ange or David, and double-
click to see in the Detail View how each of their contributions in a focus
group has been brought together. 

� While in the Detail View for the case, from the View menu or using the
toolbar icon choose Coding Stripes > Nodes Most Coding Item to
see some of the nodes used in coding this case, and the lines of text
coded by them. If you hover over the coding density bar, you will see a
list of all nodes coding the adjacent text.

Cases can have attributes, that is, a record of data known about the case that
is recorded separately from the text generated by that case. This information will
be used primarily to assist in comparing data for subgroups in your sample.

� View the attributes of a case by selecting a case, and from the RMB select
Case Properties (or Ctrl+Shift+P). Click on the Attribute Values tab to
see the values which have been assigned for this case. 

� Attribute values for all cases can be viewed (and modified) in the
Casebook (Tools > Casebook > Open Casebook). To record attribute data
for Andrew, you first need to have made a case node for Andrew. To use
the attribute data, you will need also to have coded Andrew’s text data at
his case node.

Sets in NVivo hold shortcuts to any nodes and/or any documents, as a way of
holding those items together without actually combining (merging) them. They
are used primarily as a way of gathering items for use in handling queries, reports
or models, or simply as a way of indicating that these items ‘hang together’ in
some way (perhaps conceptually or theoretically).

� Click on the Sets tab in the Navigation View, click the + to see a list of
sets, and then on a specific set to see its members.

Queries store questions you want to ask of your data. Queries might be about
the occurrence of a word or words, about patterns of coding, comparison of
groups, or some combination of these elements. They can be created and run
once, or stored to use again with more data, or with a variation. 
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Results are stored along with queries. This is a temporary, read-only area for
holding data found in answer to your queries. 

� Click on the Queries tab in the Navigation View. Expand Queries to see
its sub-folders, and select the Text searches folder. Double-click the
exciting query to see how a simple text search for the word exciting (and
its derivatives) has been set up. Click Run. The results will open in Detail
View. Use options from RMB > Coding Context to see the finds in con-
text (e.g., paragraph). (If you press Ctrl+A first, you can see the context
for all at the same time.)

� In Results > List View, double-click encouragement from supervisor to
see how encouragement to engage in research might look when it comes
from a dissertation supervisor. The text that is coded by both encourage-
ment and supervisor will show in the Detail View. If you select the result
node in the list view using your RMB, you can then select Open Linked
Query to see how that result was obtained by requesting text coded at
both encouragement AND supervisor. 

� Results from comparative queries can be viewed also (e.g., strategies x
discipline). These are useful for showing patterns of association between
project items. Double-clicking on a cell will open the text for that cell.

Classifications is a work area for setting up attributes and their values, and
types of relationships. 

� Select Classifications in the Navigation View, to see how Attributes are
set up (so values can be assigned to cases), and how Relationship Types
are defined (for use in relationship nodes).

And finally (for now), Models are used in NVivo to explore, visually,
ideas about how different project items might relate to each other.

� Select the Models tab in the Navigation View. There are a number of
models which have been created in the Researchers Project; these are
identified in the List View. Select and view detail of a model by double-
clicking its icon. To obtain a fuller view of the model, go to the Window
menu and click on Window > Docked to undock the model window
(allow a few seconds for it to open). 

Save changes? While you have been looking at the Researchers pro-
ject, you may have been warned that it was 15 minutes since the pro-
ject was last saved, and asked if you wanted to save changes made to
the project. This is NVivo’s way of making sure that you are regularly
saving changes to your project, in case of power failure or freezing.
When you are working on your own project, it is strongly recom-
mended that you save each time you are asked, unless you are simply
experimenting, do not want to save your changes, or you are in the
middle of an Undo operation.
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Close the project by selecting File > Close Project or, if you want to quit
working in NVivo for the time being, choose to Exit.

� If you would now like to convert your existing N4, N5, N6 or NVivo 1 or
2 project so you can explore it in the new NVivo, then search for the key-
word ‘legacy project’ in Help for information to assist you. 

ABOUT THIS BOOK

The multiplicity of approaches to analysis of qualitative data poses particular
problems for a book of this nature, with the purpose of walking you through a
project: How best to organize and sequence the tasks and the introduction of dif-
ferent tools? As there is no standard pathway through a project, I don’t expect
everyone to work straight through this book.

The book is organized along broad sequential stages in working from raw
data through conceptualization to strategies for analysis. You will need to step
forward or back at various times to find the instruction, suggestions or discus-
sion you most need for particular points in your project. Following the chapter-
by-chapter sequence will take you through all the elements you need to
consider: this may be the best general approach for someone new to the soft-
ware. Those who already have some knowledge of the software from earlier
versions may use the brief description of each chapter or the Table of Contents
to identify where the major discussion of a topic they might be looking for is
to be found within the chapters. A more detailed index is provided, of course,
at the end of the book.

Instructions for various activities will be found throughout this book, but I will
also provide the terminology needed to identify the appropriate topics in the Help
files accompanying the software, so that these may be accessed for more detailed
information. There are two kinds of Help provided within the software: Using
the Software provides detailed instructions on how to perform various opera-
tions, while Your Research in NVivo suggests ways and provides examples for
how you might apply particular tools. The Help files are both detailed and com-
prehensive, and they will be updated as the software is updated. They can be con-
sulted, therefore, to resolve any discrepancies between my instructions or screen
shots and the software that might result from ongoing updates to the software.
Help can be accessed at any time, either via the Help menu or by pressing the F1
key on your keyboard. Use the Index, or click on the Search tab, type in a key-
word for what you are looking for and press Enter to find what you want.
Clicking on blue hyperlinks will expand the notes to provide further detail and
examples for many topics, and links at the bottom of the screens will take you to
related topics.
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Chapter outline

Chapter 2: Starting a project may surprise you as it suggests not that you start
when you have data, but that you start a project in NVivo well before you have
begun making data. Begin with a question and your thinking around that ques-
tion, or perhaps with a theory, some literature and a model. By starting your pro-
ject in NVivo earlier rather later, you will lay a sure foundation for working with
data and verifying the conclusions you draw from them.

Chapter 3: Making data records provides guidance on making and managing
data records in NVivo, including transcriptions, notes from literature and other
documentary sources, external (non-file) sources, pictures and tables. 

Chapter 4: Working with data outlines the day-to-day activities of reflecting
on the text and coding as you work through your first documents. Suggestions
are given for when and how to use memos, annotations and other links. Different
ways of thinking about and doing coding are reviewed. Then, complete your
initial analysis by creating a model of what you have learned from this case.
Chapter 5: Connecting ideas introduces you to two different ways in which you
might think about making connections between the concepts you are working
with: by sorting them into a hierarchical (tree-structured) classification
system in which like types of concepts are stored together; or by identifying those
which ‘hang together’ conceptually or theoretically using sets, relationship nodes,
queries or models. Chapter 5 also offers a number of practical tips for managing
the coding process.

Chapter 6: Managing data reviews how you can make use of folders, sets and
cases in managing your data sources and to refine the questions you ask of your
data. Discover how to store demographic and other kinds of information as
attributes of cases, different ways of entering these into your project, and how to
use them to make comparisons and examine patterns in your data.

Chapter 7: The ‘pit stop’ suggests you pause to view your data from the per-
spective of the category rather than your sources, and perhaps to refine the cate-
gories you have developed. You might also explore, code or investigate your data
using text search, revisit the literature, and play with models using styles and
groups, to build on your case knowledge and refine your theoretical thinking.

Chapter 8: Going further takes you beyond code and retrieve methods to
explore applications of the analytic tools offered by NVivo, tools which will
assist you in exploring cases, essences of experience, narrative and discourse, as
well as in developing and testing theory.

Updates: Please check my website www.researchsupport.com.au for update
information regarding instructions given in this book.

NOTES

1 Although this book is based on the use of NVivo (versions 7 and later), the tasks to be undertaken
and the logic of use could well be applied to several other qualitative data analysis software pro-
grams (with some limitations and occasional opportunities). For a review of programs available,
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indicating strengths and weaknesses of the different programs on offer, and for access to
developers’ websites (most allowing downloads of sample or demo software) go to http://caqdas.
soc.surrey.ac.uk

2 NUD*IST stands for Non-numerical Unstructured Data – Indexing Searching and Theorizing and
so describes both the kind of data it was designed to work with, and the processes involved in
working with that data. The full title of NUD*IST was replaced with just N for the release of
versions 5 and 6 (also NVivo), in recognition of problems emanating from the dawn of an era of
web searching.

3 Kelle (1997) traced the assumption that programs were written to support grounded theory to the
need for a methodological underpinning for analysis, and grounded theory is one of the few
methodologies where authors have been prepared to be explicit about what it is they actually do
in analysis – although, as Kelle goes on to point out, “a closer look at the concepts and proce-
dures of Grounded Theory makes clear that Glaser, Strauss and Corbin provide the researcher
with a variety of useful heuristics, rules of thumb and a methodological terminology rather than
with a set of precise methodological rules” (1997, #3.4).

4 One further issue of practical concern to researchers in money-strapped institutions is that they
often will not support researchers’ access to the software. The lobbyist might suggest to the rele-
vant IT or Research Committees that statistical software be withdrawn from the quantitative
researchers, or that administrators and libraries return to their card filing systems, for in refusing
to provide access to qualitative data analysis software they are asking the ever increasing numbers
of qualitative analysts to stay with pre-computer technology, when specialist software that will
render their work more efficient and more effective is available.

5 Lyn Richards has written a series of interactive tutorials using the Volunteering project (the sam-
ple project supplied with the software), which some readers may wish to work through as an addi-
tional way of learning the software. They are available at www.sagepub.co.uk/richards.
Additionally, Getting Started macromedia tutorials which illustrate features of and tools in the
software can be accessed via the Help menu in the software (Help > NVivo Tutorials).

6 If you don’t yet have the software, you can purchase it through the QSR web site (www.qsrinter-
national.com), or download a free trial version from the same site. You will then have 30 days to
explore it before having to decide whether to buy or not.
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